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Vantage Premium 2.2 
Quick Start Tutorial 

This document is intended to help you to start using WebSpy Vantage Premium. For more 
detailed information, please see the Vantage Premium help guide. This can be accessed via Help | 

Contents on the main menu.  

Please send all issues or queries to WebSpy support (support@webspy.com)  
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This document is intended as a guide only. It aims to introduce the reader to issues that may be relevant to their organization, and 
to point out sources from which more detailed information may be obtained. It is NOT a substitute for professional legal advice. 
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Quick Start Tutorial 
Thank you for downloading or purchasing WebSpy Vantage Premium. 

This tutorial will guide you through Vantage Premium's main functions to help you start 
analyzing and reporting on your network log files. 

These functions include: 

 Importing your log files into a storage. 
 Running an Analysis on your storage. 
 Browsing your Summaries. 
 Applying Aliases to your Summaries. 
 Creating and Generating reports. 
 Creating and running tasks. 

Importing log files 
Vantage Premium enables you to analyze and report on the information contained within log 
files from common network devices such as proxy servers, firewalls, routers and gateways. For a 
list of supported formats, please visit our website. 

Before you can start analyzing and reporting on your network data, you need to import your log 
file data into a storage. Storages are optimized for quick data access so you can analyze and 
report on the data you're interested in faster. 

This tutorial uses Sentinel.log included with the application you downloaded. Sentinel is a packet 
capture tool that you can install on your network to log network traffic. 

Try this: Import log files into a storage: 

1. Open Vantage Premium and click the Storages tab at the top of the screen. This takes 
you to the Storages dock. 

2. Click the Import logs link in the 'Inputs' task pad. This launches the Input dialog. 
3. On the Storages page, click the 'Create a new storage' radio button and enter the name 

'My Storage' into the 'Name' edit box and click Next. 
4. On the Input Type page, select 'Local or networked files and folders' and click Next. 
5. On the Input Specifications page, select the format 'WebSpy' and click Next. 
6. On the Input Selection page, click Add | File. Navigate to ‘My 

Documents\WebSpy\Vantage Premium 2.2\Logs’, select ‘WebSpy Sentinel.log’ and click 
Open. 

7. Click OK on the Input Dialog to begin the import process. 
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Optimization Tip:  You can get better performance out of Vantage Premium by configuring 
some of the settings on the 'Advanced' pages of the Inputs dialog. For 
more information see Advanced Importing Features  

While Vantage Premium imports data, it also runs an analysis on your data at the same time. 
This analysis is then saved back into the storage. This means that every time you want to analyze 
the storage, the first level of Summaries are instantly available. 

As Vantage Premium imports WebSpy Sentinel.log, you can view the progress of the import on 
the Storages dock. The Storages dock displays the size of the log file (illustrated as size imported 
/ total size), the number of records imported, and the percentage complete (shown in the 
progress column). It also shows the format of the log file. This is useful if you are importing 
multiple files of different formats. 

Any issues that are encountered during the import are displayed at the bottom of the screen. 
For more information see Import Issues in the help file. 

If any of the log files you have imported are still being updated by your logging device, you can 
easily import the new hits by clicking the Import all new data link in the 'Inputs' task pad. You 
can also clear all the imported hits and reload the information from your log files by clicking the 
Reload all link in the 'Inputs' task pad. 

Running an Analysis 
Running an Analysis is the process of reading the information in your storage and creating 
Summaries.  Summaries can be interactively browsed and filtered using the Summaries dock, 
enabling you to drilldown into all areas of your network activity. 

There are two types of Analyses: 

 Ad-hoc Analysis: 
An Ad-hoc Analysis displays all 'top-level' or 'overview' Summaries that you can 
drilldown into. When you drilldown, Vantage Premium runs another analysis to retrieve 
the next group of Summaries from your storage. This type of analysis is great for 
interrogating your data on demand, but it is recommended that you only perform Ad-
hoc Analyses on relatively small amounts of data, such as a day or a week, as the time it 
takes to perform each drilldown is affected by the amount of data Vantage Premium 
needs to analyze. 

 Template Analysis: 
If you know what you want to analyze, such as the top 10 users and the largest file 
downloads, you can create an Analysis Template that displays just this information, and 
select it when running an analysis. This is effectively the same as running a report, only 
the results are displayed in the Summaries screen, allowing you to drilldown past what 
has been defined in your template.  
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You can select the type of analysis you want to run from the 'Analysis Type' page of the Analysis 
dialog. 

Try this: Run an Ad-hoc Analysis: 

1. Click the Summaries tab at the top of the screen. This takes you to the Summaries dock. 
2. Click the New Analysis link in the 'Summaries' task pad to launch the Create Analysis 

dialog. 
3. Select 'My Storage' from the 'Storage' list. 
4. Select 'Sentinel Web' from the 'Schema' list. 
5. Click Next. 
6. On the Analysis Type page, select the 'Ad-hoc Analysis' radio button and ensure 'Use 

precalculated analysis if available' checkbox is checked.  
7. Click OK. 

Note:  You can filter the analysis using the Filter page. For more information see Filtering. You 
can also select the summaries that you want created using the summaries page. For 
more information see Summary Selection. You can filter the analysis using the Filter 
page. For more information see Filtering. You can also select the summaries that you 
want created using the summaries page. For more information see Summary Selection.  

To create a Template Analysis, simply select the Analysis Template you want to run from the 
'Template' drop down list on the Analysis Type page.  

Once your analysis has been run, you can interactively browse your Summaries. 

Browsing Summaries 
Once an Analysis has been run, Vantage Premium displays all the generated Summaries in the 
Summaries dock. The Summaries dock is a powerful interface that enables you to interactively 
analyze any information contained in your imported log files. 

You can toggle the Summary Tree on or off using the button at the top of the screen. This lists all 
available Summaries and allows you to quickly jump to any Summary at any given drilldown 
level. 

The right-hand pane also displays the list of Summaries for the schema you analyzed. Each 
Summary that contains more than one item is hyperlinked. Clicking a hyperlinked summary 
takes you to the corresponding summary where you can view the actual information. 

Try this: Viewing Summaries: 

1. Toggle the Summary Tree to on by clicking the button. 
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2. Click on User Summary in the Summary Tree. All the Users in your storage are displayed 
in the right hand pane. The number of Hits, Duration and Size of data transmitted are 
also displayed. The bottom right hand pane charts the top 25 items in the Summary.  

3. Click the 'Hits' column heading to sort the Summary by this field. You will notice the 
vertical axis of the chart changes depending on the column you are sorting by. 

You will notice that the Summary items in the right hand pane are hyperlinked.  You can 
drilldown into any Summary item to view Summaries that pertain only to that summary item. 

Try this: Drilldown into the User with the most number of Hits: 

1. Click the User at the top of the list. Vantage Premium performs a drilldown and retrieves 
all the Summaries that pertain to that User.  

2. Once the drilldown is complete, all the generated Summaries are listed underneath the 
User in the Summary Tree. Click next to the User to display the list of generated 
Summaries. 

Once you have drilled down into a specific Summary item, you can view any Summary by 
selecting it in the Summary Tree. You can then repeat the Drilldown process with any of the 
Summary items displayed. 

You can also Drilldown into a Summary item and jump to a specific Summary in one easy step 
using the right-click Drilldown function. 

Try this: View the Site Profile for a specific User using the right-click Drilldown function: 

1. Go to the User Summary by clicking this Summary in the Summary Tree.  
2. Right-click on the first User in the list and select ‘Drilldown’ from the pop-up menu. 
3. Select the Site Profile Summary from the sub-menu. 

Vantage Premium then performs a drilldown into the first User in the list and displays the Site 
Profile Summary. 

Your drilldown path is displayed at the top of the right hand pane. You can easily jump back to a 
previous level by clicking the appropriate button in this drilldown path. You can also select a 
different Summary at any level by dropping down the drop down menu on any of these buttons 
at the top of the pane. You can also use the Summary tree to browse through all your drilldowns 
and Summaries. 

You can also filter the list of summary items using the Find edit box at the top of the screen. 
Simply enter the term you want to filter by and click the Find button. To clear the filter, click the 
Clear button. 

Try This: Find all Google web sites: 

1. Click the Site Name summary in the Summary Tree.  
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2. Enter 'Google' into the edit box in the Find task pad. All the sites that includes Google 
are displayed in the list. 

Once you are confident browsing your Summaries and drilling down into Summary items, you 
can utilize the Summaries dock to dynamically extract any information you want to analyze from 
your imported log files. 

Applying Aliases 
When browsing your Summaries, you may want to group items together or represent some 
Summary items with more meaningful names. It is possible to perform these functions using 
Aliases. 

For example, if you are viewing the Users contained within your User Summary, you may want 
to show the users actual name, or a shorten name to what is actually contained in the summary. 

Some example Aliases are provided with the Vantage Premium install file you downloaded.  

Try this: View the list of sample aliases: 

1. Go to the Aliases dock by clicking the Aliases tab at the top of the screen. 
2. Select any alias on the left to view the Alias Groups and Items in the right hand pane. 

The Alias Group is the name that will be displayed when any of the Group's Items match 
a Summary Item.  

Any of these aliases can be applied to your Summaries in the Summaries dock using the Apply 
Aliases button on the toolbar in the right hand pane. 

Try this: To apply Aliases to your Summaries: 

1. Return to the Summaries dock by clicking the Summaries tab at the top of the screen. 
2. Ensuring you have the 'My Storage' Analysis open (created in the topic ‘Running an 

Analysis’), select the User Summary in the Summary Tree. 
3. Select 'Departments' in the Aliases task pad. All the Users are now represented by 

Department Names. Any Users that do not match a Department Name are grouped into 
the 'Unknown' Alias Group. 

Aliases only apply to specific Summaries. This is configured on the Aliases dock and is explained 
in the topic ‘Configuring Aliases’. When browsing your Summaries, only Aliases that apply to the 
Summary you are viewing can be selected in the Aliases task pad.  

Once an alias has been applied, you can drilldown into it as you can with any other Summary 
item. 
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Creating Reports 
Vantage Premium enables you to produce report documents which you can send to other 
members of your organization, or archive. 

The Reports dock enables you to configure and generate reports as well as manage any existing 
reports. To access the Reports dock, click the Reports tab at the top of the screen. 

All Report templates are listed on the Reports screen. Each template has an Edit button and a 
Generate button. At bottom of the screen is the Reports Manager pane that lists all previously 
generated reports. 

You can create three types of reports: 

 Analysis Reports 
Analysis Reports enable you to define customized drilldown paths and Summaries. 
Analysis Reports can be generated as a printable or online report, or viewed in the 
Summaries dock by running an Template Analysis (see ‘Running a Template Analysis’). 

 Trend Reports 
Trend Reports utilize statistical functions to calculate trends over time and predict 
values in the future (see ‘Creating Trend Reports’) 

 Comparison Reports 
Comparison Reports enable you to quickly define up to four drilldowns that you want to 
view. The process of creating a Comparison Report is explained below. 

Try this: Create a quick Comparison report: 

1. Click the Reports tab at the top of the screen. This takes you to the Reports dock. 
2. Click the Comparison Reports tab at the top of the Reports screen. 
3. Click the New Template link in the Templates task pad. This launches the Add Template 

dialog. 
4. Type 'My Comparison Report' in the Name edit box. 
5. Select 'Sentinel Web' from the Schema drop down list. 
6. Select the 'Comparison' radio button and click OK. A new Comparison Report Template 

is added to the Reports screen.  
7. Click the Edit button on this template. 
8. Ensure the '1' check box is checked enable the options for the first drilldown. 
9. Select User from the ‘Summary’ drop down list and select Usernames from the ‘Alias’ 

drop down list. Select Hits from the ‘Order By’ drop down list. 
10. Check the '2' check box to enable the options for the second drilldown. 
11. Select Site Name from the ‘Summary’ drop down list and select Hits from the ‘Order By’ 

drop down list. Leave the ‘Alias’ drop down list set to none. 
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You have now configured a Comparison Report to drilldown into Users and display all the Site 
Resources for each one. You can now generate the Comparison Report to create a printable or 
online document (explained in the next topic ‘Generating Reports’). 

You created an Analysis Report in the topic ‘Creating an Analysis Template’. In addition to being 
able to run it in Summaries (see ‘Running a Template Analysis’) you can use it to generate a 
printable or online document (see ‘Generating Reports’). 

Generating Reports 
Vantage Premium comes with a list of predefined report templates that you can generate. You 
can also create your own customized report templates. 

Reports can be generated in the following formats: 

 Web Document (MHT) 
 Web Document (HTML, Loose files) 
 Microsoft® Word Document (DOC) 
 Text Document (TXT) 
 Comma Separated File (CSV) 

Try This: Generate a report: 

1. Click the Reports tab at the top of the screen. This takes you to the Reports dock. 
2. Select the tab that contains the Report Template you want to generate.  In this case, 

select the Comparison Reports tab. 
3. Select 'My Comparison Report' you created in the previous topic and click the Generate 

button located on the template. This launches the Generate Report dialog. 
4. On the Storages Tab, check 'My Storage' that you created in the topic ‘Importing log 

files’. Click Next. 
5. On the Format Tab, click the ‘Web Document MHT’ radio button. This will create an 

MHT file which is a packaged HTML document. Click Next. 
6. On the Publish Tab, enter 'My Generated Report' in the Name edit box. Check the 

'Display the report using the default viewer' checkbox. Click Next. 
7. Click OK. 

Vantage Premium then generates the report and opens it using the default viewer for the 
format you selected in step 5. 

Web Document MHT reports can be created as a packaged document (MHT) or as loose HTML, 
where all the graphics, styles and html pages are contained in a folder. MHT files can only be 
viewed in Microsoft® Internet Explorer. To view HTML reports in other browsers, generate them 
as loose HTML. 
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Note:  You can filter your reports using the Filter tab of the Generate Report dialog. For more 
information see Filtering. There are also other publishing options for reports such as 
emailing the report and copying it to a location. For more information, see Report 
Publishing. You can filter your reports using the Filter tab of the Generate Report dialog. 
For more information see Filtering. There are also other publishing options for reports 
such as emailing the report and copying it to a location. For more information, see 
Report Publishing.  

You can also create a separate report document for each item in a Summary. For example, you 
can create a separate report for each user or each department in your organization.  

Creating Tasks 
Most actions you perform in Vantage Premium can be set to run automatically as part of a task. 
Importing data and running reports can therefore be done overnight, ready for you in the 
morning. 

To create a task: 

1. Click the Tasks tab at the top of the screen. This takes you to the tasks dock. 
2. Click the New Task link in the Tasks task pad. This launches the Task Options dialog. 
3. On the General page, enter a name for your task such as 'Weekly network usage report 

task'. Click Next. 
4. On the Schedule page, check the 'Run task using Windows Task Scheduler' check box. 

The 'Key' that is displayed can be used to identify the Windows Job that gets created. 
5. Select when you would like the task to run. For example, Start: 01/05/2005 at 06:00:00, 

Recurrence: Weekly - every 1 week on Fridays. Click Next. 
6. On the Authentication page, enter the Windows user name and password that you 

want the task to run as, for example 'mydomain\john.citizen'.  
7. Click OK. 

Tip:  You can receive notification each time your task runs, by configuring the task to send results 
to an email address using the 'Send task results by email' option on the General page. You 
can receive notification each time your task runs, by configuring the task to send results to 
an email address using the 'Send task results by email' option on the General page.  

Now that you have created a task, you can add actions to the task. 

To add actions to a task: 

1. Select the task you created in the Tasks list. 
2. Click the Add Action button in the right-hand pane and select the action you want to 

run.  
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3. The action will be added to the Actions list and will include a number of sub-actions. For 
example, the 'Run a comparison or analysis report'' task action has two sub-actions: 
'Select template' and 'Configure report'. 

4. Double-click each sub-action to configure them. 
5. Once you have added all the actions you want the task to run, and configured all the 

sub-actions, you can run the task by clicking the Run Task link in the Tasks task pad. This 
is a good way to test that the task is working as you expect. 

6. Once you are happy with your task, you can leave it to run as scheduled. 

Tip:  Tasks are not only useful for running actions at convenient times, but also for setting up 
batch jobs. For example, if you always want to run a set of 10 reports, you can configure a 
task that runs these reports, and simply click the 'Run Task' button when you want to 
generate those reports. This is much more convenient than generating each report one by 
one. On the Task Options dialog, uncheck the 'Run task using Windows Task Scheduler' check 
box' so that the task doesn't try to run at a scheduled time. Tasks are not only useful for 
running actions at convenient times, but also for setting up batch jobs. For example, if you 
always want to run a set of 10 reports, you can configure a task that runs these reports, and 
simply click the 'Run Task' button when you want to generate those reports. This is much 
more convenient than generating each report one by one. On the Task Options dialog, 
uncheck the 'Run task using Windows Task Scheduler' check box' so that the task doesn't try 
to run at a scheduled time. 

Once completed, task results are displayed in the ‘Last Results’ section of the selected task. 

 

These results can also be sent by email. This option can be found on the General page of the 
task options, accessed via Edit Task. 
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End of Tutorial 
That concludes the quick start tutorial. You should now have enough information to start using 
Vantage Premium to analyze and report on your own log files. 

If you require more information, please visit the WebSpy web site at www.webspy.com. You can 
also contact WebSpy Support by emailing support@webspy.com or visiting our support page 

If you are testing a pre-release version of this product, such as a technology preview, beta, or 
release candidate, please submit your feedback using our beta feedback page. 

If you would like to receive updates when pre-release versions are made available, as well as get 
access additional testing resources, please register as a WebSpy beta tester by submitting your 
details using our beta registration page. 

Thank you for using WebSpy Vantage Premium. 
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